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Welcome to your 
new Audient iD24 
Audio Interface

Inside the box:

• iD24

• USB Type C Cable

• Quick Start Guide

To help get you started please visit  

audient.com/products/iD24

to download the latest software 

and firmware.

Features include:

• 2 x Class-A Audient Console Mic 

Preamps

• Class Leading AD/DA Converters

• 1 x Discrete JFET Instrument Input

• Main and Alt Speaker Outputs

• 1 x Independent Dual Headphone 

Output

• 1 x ADAT Input & Output

• 2 x Fully Balanced Inserts

• Ultra-low Latency DSP Mixer

• Audio Loop-back

• ScrollControl

• 3 x User Defined Function Keys

• Dedicated Dim and Cut Controls

• +48V, Pad, and HPF Switches

• USB 3.0 Compliant

• 24bit/96kHz

• Word Clock Output

• All-Metal Design

• Free Software + Plugins

https://audient.com/products/audio-interfaces/id24/overview/
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iD24 Overview
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Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting and 

powering up iD24.

The iD24 itself does not operate with any high voltage mains supply inside the unit but appropriate 

safety measures should still be adhered to regarding the USB supply.

Consult a qualified technician if you suspect di�culties. Do not attempt to tamper with the power 

supply or mains voltages - HAZARDOUS TO HEALTH. To reduce risk of fire or electrical shock, 

DO NOT expose this apparatus to rain or moisture.

Safety Information

No user serviceable parts inside.

Please refer servicing to qualified 

service personnel. You can find more 

information at support.audient.com

WARNING!

https://support.audient.com/hc/en-us
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Important Safety Instructions

1. Read these instructions

2. Keep these instructions

3. Heed all warnings

4. Follow all instructions

5. Do not use this equipment near water

6. Clean only with dry cloth

7. Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment  

(including amplifiers) that produce heat

8. Only use attachments/accessories specified by the manufacturer

9. Unplug this equipment during lightning storms or when unused for long periods of time

10. Refer all  servicing to qualified service personnel.  Servicing is required when the equipment 

has been damaged in any way, such as power supply cord or plug is damaged, liquid has 

been spilled or objects have fallen into the equipment, the equipment has been exposed to 

rain or moisture, does not operate normally, or has been dropped

11. For products that are a mains powered device: The equipment shall not be exposed to dripping 

or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment

Safety Information
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Declaration of Conformities

FCC Part 15B

This apparatus has been tested and found to comply with the limits of a class-A digital device, pursuant to Part 15B of 

the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 

installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 

accordance with the instructions, may cause harmful interference to radio communications. If this equipment does 

cause harmful interference to radio or television reception, which can be determined by turning the equipment o� 

and on, the user is encouraged to try to correct the interference by one or more of the following measures:

 1. Re-orient or relocate the receiving antenna

 2.  Increase the separation between the equipment and receiver

 3.  Connect the equipment into an outlet on a di�erent circuit from that 

  to which the receiver is connected

 4. Consult the dealer or an experienced radio/TV technician for help

  We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 

  01256 381944, declare under our sole responsibility that the product iD24 

  complies with Part 15 of FCC Rules. 

  Operation is subject to the following two conditions:

  1.  This device may not cause harmful interference,

  2.  This device must accept any interference received,

   including interference that may cause undesired operation

Audient Ltd has conformed where applicable, to the European Union’s Directive 

EN 63000:2018 on Restrictions of Hazardous Substances (RoHS) as well as the following 

sections of California law which refer to RoHS, namely sections 25214.10, 25214.10.2, and 58012, 

Health and Safety Code; Section 42475.2, Public Resources

We, Audient Ltd, declare that the product, the iD24, to which this declaration  

relates, is in material conformity with the appropriate CE standards and  

directives for an audio product designed for consumer use.

We, Audient Ltd, declare that the product, the iD24, to which this declaration  

relates, is in material conformity with the appropriate UKCA standards and  

directives for an audio product designed for consumer use.



Installation



9

Mac Installation

System Requirements

macOS 10.11.6 (El Capitan) or Later 

Mac Intel CPU or Apple Silicon

1GB RAM Minimum

1. Download the latest iD 

Software

Head to our website for the latest version 

of our iD Mixer:

audient.com/products/downloads/

id24

Drag the downloaded app into your 

application folder to install it. 

2. Connect iD24

Using the USB cable provided, connect 

iD24 to your computer’s USB port.

USB - C

https://audient.com/products/audio-interfaces/id44/overview/
https://audient.com/products/audio-interfaces/id44/overview/
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3. Status LED

Once connected to your computer and 

powered on, the white status LED on iD24 will 

illuminate.

If at any time the status LED turns o� during 

normal operation please check all connections 

and if further problems develop please 

contact Audient support.

4. Double Checking Connectivity 

To ensure iD24 has been detected by your 

computer and correct clocking sources are 

set-up, navigate to:

Macintosh HD > Applications > 

System Preferences

Check that iD24 is set as your audio device. 

It’s recommended to disable system sounds.

It’s also worth checking Audio MIDI Setup

(found in Mac HD > Applications > Utilities).

Window > Show Audio Window

Here you should see iD24 report with 10 

inputs and 14 outputs. The clock source is 

configured in the iD app. See page 24 for 

more details.

5. Open the iD Mixer

Run the iD Software. It will appear as an icon 

in the Menu bar of MacOS. Click on this and 

select ‘Open Mixer Software’.

Mac Installation



Mac Installation
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Menu/Task Bar Icons

On MacOS, the iD icon appears in the menu 

bar in the top right hand corner of the screen. 

This gives you quick access to various functions 

of the iD24. 

Show Mixer 

If the mixer window has been hidden, this  will 

bring it back to the forefront.

Quit

Fully closes the iD Software Mixer application. 

About iD 

Displays information regarding the current 

version of the iD Software Mixer application 

and firmware.

Visit iD Knoweldge Base

Opens a browser windows for the Audient 

Helpdesk with helpful articles and FAQs.

Check for Updates

The iD app will check with the Audient update 

server for any available firmware updates for 

iD24.

Top Tip

Right click on the iD icon in the Dock and select 

Keep in Dock to have quick access to the iD mixer 

app at all times.



Windows System Requirements:

Windows 10 or later (32 or 64 bit)

Intel Core 2 @1.6Ghz, or AMD equivalent 

1GB RAM Minimum

1. Download the iD24 Software

Head to our website for the latest version of 

our iD Windows Installer:

audient.com/products/downloads/

iD24

2. Connect iD24

Using the USB cable provided, connect iD24 to 

your computer’s USB port.

3. Run iD Mixer Setup

Double click on the installer to run the iD mixer 

setup and follow the on-screen instructions.

4. Reboot PC

Reboot your PC to make sure that all the 

drivers have been installed.

Windows Installation
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https://audient.com/products/audio-interfaces/id24/overview/
https://audient.com/products/audio-interfaces/id24/overview/


4. Check Connectivity

The USB status LED will illuminate as soon 

as iD24 has achieved stable communication 

and should remain solidly lit during operation 

of the unit until power down.

To double check the connection, go to PC 

sound settings by following:

PC Settings > Control Panel > Hardware and 

Sound > Sound

Here you can make it the computer’s default 

sound device by selecting the unit and clicking 

“Set Default Device” on both the Playback 

and Recording Tabs.

iD Icon

Once installed, the iD icon can be found in the 

Windows system tray (it may be in the hidden 

icons area):

• Double-click to open the iD24 mixer 

window when iD24 is connected.

• Right-click to quit or change sample rate 

and bu�er size.

For mixing, a bu�er size of 256 should be 

perfect. For tracking, experiment with lower 

bu�er size values. 

Various factors including how powerful your 

computer is, and how processor hungry your 

project is, will a�ect how low you can get 

the bu�er size settings before you get audio 

instability. 

More information on optimisation can be 

found on our support site. 

13



iD App & Firmware Update
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Launch the iD Mixer Application

Launch the iD24 Software Mixer application 

by finding it in the following folder:

Mac OS

Macintosh HD > Applications > iD 

 

Windows 

Start > All Programs > Audient > iD

On macOS, the iD app will launch into the 

Menu bar, in the top right corner of the 

screen. Click on the small iD icon to access 

the features of the application. 

On Windows, the iD app will launch into 

the system tray, typically in the bottom right 

corner of the screen. Right click on the iD icon 

to access the features of the application. 

For more information on the mixer application 

feature set, please refer to page 28 onwards 

of this manual.

Check for Firmware Updates

If your computer is connected to the internet, 

the iD app will check for firmware updates

whenever a unit is connected. If there is a 

firmware update available then the iD app

will notify you.

You can manually check for updates by going 

to the Help menu and selecting ‘Check

for Updates’. It will notify you if you’re on the 

latest version of firmware or if you need to 

update. 

Registration With Audient ARC

When you first open the iD Software Mixer 

a window will open asking you to register 

your unit to Audient ARC. Simply follow the 

instructions on-screen to create an account 

and register your unit. 

This will give you access to free innovative 

software and services; meaning you’ll have 

everything you need to get recording straight 

away. 

If you plan on registering the product at a 

later time, then you can simply close the 

registration window. You’ll see the window 

again the next time you use the unit.



Hardware Features
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Microphone Preamplifiers

& Line Inputs

iD24 features two classic Audient Console 

microphone preamplifiers. These preamps

are based on designs from Audient’s classic 

consoles and are the same that are used

across our entire ‘iD interface range’.

The design features discrete Class-A circuitry 

providing exceedingly low distortion and

noise performance. From a sonic point of 

view, iD24 is fast, open and detailed.

Amphenol ™  XLR/TRS Jack combi-connectors 

provide microphone and line inputs. The line 

inputs are padded by -10dB before passing 

through the microphone preamplifiers to 

minimise clipping on line-level signals. 

The microphone preamplifiers 

feature:

• • 58 dB of clean gain

• • >2.8kΩ input impedance which 

provides a punchy tone from any 

microphone transducer type



Instrument Input

iD24 employs a discrete class-a JFET 

instrument (D.I) input on channel one which 

is easily accessible on the front of the unit.

The JFET circuitry adds a tiny bit of colour 

and harmonics to the signal, making it sound 

great on guitars and basses.

Plugging in a TS (tip-sleeve unbalanced) jack 

will override the mic signal and turn channel 

one into a fully-fledged, fantastic-sounding 

instrument input.

Phantom Power Switch

There is an independent phantom power 

switch for each microphone channel. This 

provides full phantom power (48V ±4v, 10mA 

per channel) to the microphone connected to 

this channel. 

Please note that the iD24 will only send 

phantom power to XLR connections, the TRS 

line inputs will not receive phantom power.

-10dB Pad

Both inputs feature a switchable hardware 

-10dB pad to help lower signal level when 

recording particularly hot sources such as 

drums. 

17
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High Pass Filter

Each pre-amp also includes a switchable 

hardware high pass filter that will remove 

frequencies below roughly 80Hz. This is good 

for removing rumble and room noise from 

your recordings.

Balanced Inserts & Returns 

On both input channels, the iD24 features 

a dedicated insert allowing you to connect 

outboard gear to your recording chain; 

Just like the workflow you would find on an 

Audient console! 

The two channels feature an electronically 

balanced send and an electronically 

balanced return, all before the analogue to 

digital (AD) converters.

Insert your favourite hardware EQ and 

compressor into the insert and with the 

super clean Audient preamps you can build 

vocal chains that will rival the best out there!

Insert Normalling 

The Insert send and return jacks are half-

normalled meaning you don’t need to patch 

the two together when not in use. The internal 

signal chain is only broken when a jack is 

plugged into the return.

Plugging a jack into the Insert send will split 

the signal which can be useful for parallel 

processing.

Patching Inserts

To incorporate your favourite processing 

before conversion, simply patch the iD24 

Insert send into the first piece of gear in your 

processing chain. Then take the output of the 

last device in the chain and patch this into the 

iD24 Insert return. 
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Direct Access to ADC

The Insert return connection on the iD24 

is an electronically balanced input stage 

that directly drives the analogue to digital 

converter (ADC) for that channel. As such, 

this is a great place to input signals directly 

to the ADC, bypassing the internal Audient 

preamplifiers and minimising any colouration 

of the signal. 

This makes it useful to patch in external 

microphone preamplifiers without adding 

additional colouration or noise. It is also 

handy for using the iD24’s outputs to drive 

external e�ects before returning them into 

your DAW using the insert returns.

Please note; the digital calibration level of 

the iD24’s converters is 0dBFS = +12.5dBu.
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Neutrik

Neutrik

D.I 1

Auto 

Sense

 Input 

Select

ADC

+58dB

+58dB

ADC

Insert

Insert

Direct 
Monitor

Path
(software 

controlled)

CH1

CH2

OPTICAL
IN 1

Microphone Input

XLR Combi Female
Pin 1: Chassis Ground Pin
Pin 2:Hot (+ve)
Pin 3: Cold (-ve)
Input Impedance: >2.8k ohm
Maximum Input Level: +12dBu

Line Input

1/4” TRS Combi Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Input Impedance: >8k ohm
Maximum Input Level: +22dBu 

DI Input

1/4” TS Jack
Tip: Hot (+ve)
Sleeve: Ground
Input Impedance: >500K Ohms

Insert Sends

1/4” TRS Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Output Impedance: >100 ohm
Maximum Output Level: +22dBu

Insert Return

1/4” TRS Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Input Impedance: >10k ohm
Maximum Input Level: +12.5dBu
Digital Reference: 0dBFS = +12.5dBU

Optical Inputs

TOSLink Optical Connector
ADAT: 8 channels @ 48kHz
ADAT SMUX: 4 channels @ 96kHz
S/PDIF: 2 Channels @ All sample rates

Input Specs

Class A Mic Preamplifer, Inserts, A/D converters and

Optical Input Block Diagram

USB
OUTAuto 

Sense

 Input 

Select

Hardware Features
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Digital Inputs and Outputs

iD24 features an optical input and an optical 

output. These can be set to operate using 

optical stereo S/PDIF or 8-channel ADAT 

using the iD Software Mixer. All i/o will

operate at up to 96kHz, with ADAT dropping 

to 4 channels at sample rates of 88.2kHz or

higher.

Running in S/PDIF mode, the optical i/o gives 

you 2 channels of audio in and out of the iD24 

at sample rates up to 96KHz.

Running in ADAT mode, the optical i/o 

provides 8 inputs and outputs which are ideal 

for recording via external mic preamps. 

The ADAT outputs could connect to an 

8-channel DAC to provide additional outputs 

or to headphone distribution systems such as 

a Hearback ™ System. 

Please note, when using 88.2kHz and 96kHz 

as a sample rate with ADAT devices, you only 

have access to 4 channels of digital input and 

4 channels of digital output due to how the 

ADAT protocol works at higher sample rates.

More information on how the iD Software 

Mixer is used to route to the optical outputs 

can be found under The Routing Matrix 

section of this manual.

Word Clock Output

The iD24 also includes a BNC Word Clock 

output which allows you to clock multiple 

digital devices to the iD24’s master clock and 

keep everything in sync. 

The Word Clock output will send a clock signal 

at the same sample rate (44.1, 48, 88.2 or 

96kHz) that the iD24 is operating at. This will 

occur regardless of whether the iD24 is being 

clocked internally or externally.
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iD24 clocked via the Optical Port

iD24 with Single BNC Connection

Optical TOSlink Cable BNC Word Clock Cable

75 Ohm Terminated

Hardware Features
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Headphone Output

iD24 features an independent high-current 

headphone amplifier. This can be accessed

using both the 3.5mm and 6.35mm sockets 

found on the front of the unit. The same 

audio signal comes out of both connectors 

simultaneously, so it does not matter which 

you plug your headphones into. You can also 

plug in two pairs at the same time.

The headphone output can comfortably drive 

a wide range of headphone impedances 

meaning that you will get great-sounding 

audio no matter what model of headphones

you have. 

Speaker Outputs

iD24 has two pairs of stereo speaker outputs 

on the back panel in the form of balanced TRS 

jack connectors. The outputs are impedance 

balanced using the same topology as our

flagship console, the ASP8024.

The outputs are fed from high-quality DACs 

(Digital to Analogue Convertors) sending

clean audio to your speakers, perfect for 

critical listening.

You can use these outputs for more than just 

speakers. A good example of this is if you

want to use a dedicated headphone amplifier 

for multiple musicians, you can connect this 

up to one or more of these outputs, This is 

configured in the iD Software Mixer.
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iD Button

The iD button is used to activate iD24’s 

ScrollControl feature, which turns the encoder 

into a virtual scroll wheel allowing you to 

control compatible scrollable parameters 

within your DAW or plugins.

Simply hover your mouse over a scroll enabled 

parameter in your DAW and turn the encoder 

on the interface to adjust that parameter. 

Please note that this will not work on all DAWs 

as it relies on the DAW to have scroll wheel 

support. 

F-Keys

The three F buttons, F1, F2, and F3 are the 

function keys and allow you to activate a 

number of monitoring functions from the iD 

Software Mixer. More information on how to 

assign functions to the F-keys can be found 

on page 32.

Monitor Controls

iD24 provides excellent monitor control 

functionality using the large aluminium 

volume control and the separate headphone 

control. You also have dedicated DIM and 

CUT buttons to either reduce the level by a 

set amount, or to mute the speaker outputs 

entirely. 
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Status LED

The status LED indicates connection via USB 

to your computer. A solidly lit light means that 

there is stable communication between iD24 

and your computer.

Kensington Lock

For those who work in educational

establishments or in situations where your 

equipment is public facing and subject 

to possible theft opportunities, we have 

provided a Kensington lock hole to enable 

you to protect your iD24.

Hardware Metering

The 8-segment hardware meters indicate the 

playback level of your Main Monitoring Mix in 

the iD Software Mixer.



Software Features

26



27

Input Channels - Channel Types

The iD Software Mixer features three types of 

input channels:

Mic Inputs 

These are the inputs where you will see the 

signal from the iD24’s two analogue inputs.

 

Digital Inputs 

These are the inputs from the iD’s optical 

inputs. The number of digital inputs present 

on the iD Software Mixer depends on the 

digital input type (S/PDIF or ADAT) and the 

sample rate being used. 

DAW Returns  

These are the signals being played back 

from your DAW. The iD24 has six DAW Return 

Channels allowing you set up multiple cue 

mixes or sends to hardware outboard gear.

Using these three channel types you can 

build up your main monitor mix and up to two 

additional cue mixes.

It’s important to note that the iD Software 

Mixer only controls the monitoring of the 

iD24. Changes made to the iD Software Mixer 

won’t a�ect the level present in your DAW or 

audio software.
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Channel Name

Phase Flip

Pan Control

Stereo Grouping

Solo

Fader

Meters

Mute

+10dB 
boost
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Channel Features

Channel Name

By double-clicking on the name of the channel 

you can rename it to help you organise your 

iD Software Mixer. You could name a channel 

‘Kick’ or ‘Snare’ for example.

+10dB Boost

Selecting this will boost the incoming signal 

by +10dB for recording quiet sources. This will 

also a�ect the audio being fed into your DAW.

Phase Flip

Inverts the polarity of the signal by 180° to 

stop phase cancellation. This is useful if you

are micing the rear of a guitar amplifier or the 

underside of a snare drum.

Pan Control

Allows you to send the audio to the left, to 

the right or anywhere between on your Main 

Monitor Mix or Cue Mixes.

Stereo Grouping

Allows you to group two adjacent channels 

together into a stereo channel with a single

fader controlling the level of both channels. 

When a channel is stereo grouped, the pans 

will automatically be set to hard left and 

hard right.

Solo

The Solo button mutes all other channels 

other than the one that is currently soloed. 

Multiple channels can be soloed at one time.

Mute

The Mute button stops this channel from 

outputting audio whilst it is engaged.

Fader

The fader controls the amount of signal that 

is sent to the currently selected mix. This can 

be set to anywhere between -inf dB to +6dB.

Meter

The meter shows the current signal level in 

dBFS. Should the signal level exceed 0dBFS 

then the peak indicators will illuminate red to 

indicate a peak. The peak indicators can be 

turned o� by clicking on them. You can also 

turn o� all peak indicators using Alt + Click.
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Master Section Features

Mix Selection

Cue Mix 
Name

Cue Mix 
Level

Mix Solo

Mix Meters

Channel Views

Monitor Controls

Chronometer
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Channel Features

Mix Selection

Clicking on one of the mix tabs allows you 

to make changes to that mix. When a mix 

is selected, it expands to reveal additional 

controls for that mix.

Cue Mix Name

Double-clicking on a Cue Mixes name allows 

you to rename the Cue Mix. If, for example, 

you were creating mixes for two separate 

band members, you could name them 

‘Drummer’ and ‘Guitarist’.

Mix Solo

The Solo button allows you to audition each 

of the Cue Mixes through your monitors.

Mix Level

The Mix level allows you to control the overall 

level of the Cue Mix that is sent to the outputs.

Mix Meters

The Mix meters show the master signal level 

of the selected mix.

Chronometer

The Chronometer allows you to see not only 

the current signal level but also the signal

level from a few seconds previously.

This can be great to track down a sudden 

loud transient on a particular cue mix or to 

monitor the change in level over time as you 

make changes to a mix.

Channel Views

These three buttons allow you to control which 

of the three channel types are shown in the

mixer. If for example, you weren’t using the 

digital inputs for a particular project, you can

simply hide the optical channels by clicking 

‘OPT’.

Main Mix Volume

The large virtual knob in the master section 

controls the Main Mix output which is used to 

adjust the volume of the audio being sent to 

your speakers. This is linked to the hardware 

encoder on the unit itself. 

Monitor Controls

These six buttons control various aspects of 

iD24’s monitor controller capability. The

function of each control can be found below:

• TB (Talkback) 

The Talkback button switches talkback 

on and o�. More information regarding 

talkback and its various settings can be 

found in the ‘System Panel’ section of this 

manual. 
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• ø (Phase Flip) 

Pressing this switch flips the phase of 

one side of the stereo field. Used in 

conjunction with the Mono button, this 

can be a great way to remove centred 

elements from a mix in order to hear the 

hidden elements of a mix. 

• Mono 

The Mono button sums the stereo 

outputs down to mono. This can be used 

to quickly check the mono compatibility 

of your mix to make sure it’ll sound great 

almost anywhere! 

• ALT 

Alt allows you to quickly switch your 

monitor path to a secondary set of 

monitors to let you check how your mix 

translates on various speakers. 

 

You can select which outputs the ‘ALT’ 

monitor control flips to in the System 

Panel. 

• DIM 

Reduces the output level by a preset 

amount which can be great if you get a 

call or need to quickly chat to someone 

during a session. 

• Cut 

Cuts all signal currently being sent to the 

Main Mix of the iD24. 

Assigning F-Keys

Various functions of the iD mixer application 

can be assigned to the Function Keys of the 

iD24 to allow you to quickly control your 

monitoring at the click of a button.

To assign a monitor control to an F-Key, simply 

right click on the control and select the F-Key.



33

System Panel Features

Digital Input 
Format

Clock Source
Selection

Output 
Routing 

Selection

Routing 

Matrix
Mono Mode

Dim Level

Alt Speaker
Level

Talkback 
Device

Talkback 
Source

Input
Source
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System Panel Features

Digital I/O Format

Allows you to select whether the optical input 

uses ADAT or S/PDIF digital format.

Preferred Clock Source

The Clock source can be selected from either 

the internal clock or the optical input. More 

information about choosing a clock source 

can be found in the clocking section of this 

manual.

When using an external clock source the 

indicator beside the selector shows the 

current status of the clock on that input.

• Red - No clock signal detected on input

• Amber - A clock signal is detected but at 

a di�erent sample rate to iD24

• Green - A clock signal is detected and is 

at the correct sample rate. 

For an external clock source to be working 

correctly you would want the indicator to be 

green. 

Mono Mode

When iD24’s Mono feature is engaged this 

option controls whether the mono signal

is sent to the left, right or both monitors. 

Dim Level

When iD24’s dim function is engaged, 

this control defines how much the level is 

reduced by.

 

ALT Speaker Level

This control defines the level drop/boost 

when iD24 is switched to ALT speaker mode. 

This is used to balance levels between 

di�erent speaker brands.

Output Routing Selection

Opens the Routing Matrix for either the 

Analogue Outputs, Digital Output or the

Talkback channel.

iD Mode

Controls whether the iD button engages 

ScrollControl or one of the monitoring 

functions.
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Routing Matrix

The Routing Matrix allows you to control the 

audio source for each of iD24’s outputs

from the following options:

• Main Mix - This takes signal from the 

Master Mix of the iD Software Mixer. This 

is what is usually used for most standard 

playback. 

• ALT - This takes signal from the Master 

Mix but only when the Alt speaker mode 

is active. 

• Cue A & B  - This takes signal from the 

two cue mixes which can be created 

using the iD Software Mixer. Please note 

that the hardware volume control does 

not a�ect these mixes and the Cue’s have 

separate trims which can be adjusted 

when the Cue Mix is selected in the Main 

Mixer Window. 

 

• DAW THRU - This allows you to route to 

outputs exactly as they would appear 

in your DAW. For example, if you set 

Analogue out 1+2 to DAW THRU, anything 

your DAW sends out to Outputs 1+2 will be 

sent directly to Analogue outputs 1+2. 

 

Please note that in DAW THRU, the 

channel in question will bypass any 

volume control and audio will be passed 

at full scale. If this output is sent to a set 

of monitors without inline attenuation, this 

may be very loud. 

 

The only exception to this is the 

headphone outputs where the volume 

control will still function.
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Talkback Source 

 

The Talkback source allows the talkback input 

to be taken from one of iD24’s internal inputs or 

from an external device connected to the host 

computer (such as a built-in microphone or

USB microphone).

When you select an internal input as your 

Talkback channel,  the corresponding channel 

in the iD Software Mixer will be changed to a 

talkback channel which will have a TB button 

in the centre. If using an external device, the 

talkback signal will appear on channel DAW 6.

Talkback can be turned on or o� by pressing 

the TB button on that channel, the TB button in 

the master section or using one of the F-keys if 

assigned to the TB function.

The Talkback is only sent to the CUE mixes 

as you would not want your talkback to 

also playback through the Main Speakers. 

Therefore, faders will only appear for the 

Talkback channels on the Cue mixes, not on the 

Main Mix.

Talkback Device

If an external device is selected then this allows 

you to select which connected device is used. 
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Saving & Loading Mixer Presets

To allow you to quickly setup your iD 

Software Mixer during a session you can 

save and load various presets. This is great if 

you are moving between di�erent recording 

scenarios quite often. 

Mixer presets can be saved and loaded in 

two ways:

• Using the File menu and selecting either 

Save or Open. 

• Using standard keyboard shortcuts :  

Save:  Mac -     Cmd + S

  Windows -     Ctrl + S

Load:  Mac -     Cmd + O

  Windows -     Ctrl + O

Saving a Preset

To save a preset,  simply setup your mixer the 

way that you’d like. Then select File > Save 

as explained above. The iD Software Mixer 

window should then show the ‘Save mixer 

Configuration’ dialog.

Simply enter the name of your preset and 

press the ‘Save’ button.  

It is also possible to export your preset files 

in order to send them to friends or to simply 

save them within your DAW session files for 

easy recall later on. To do this, select Export 

Mixer Configuration at the base of the Save 

screen.

Loading a Mixer Configuration

To load a previously saved preset, select 

File > Open to bring up the ‘Load’ screen.

The previously saved configuration will 

appear in a list.  Select the configuration you 

wish to use and click Load. 

You can also open a mixer configuration 

directly from your computer’s file system 

by selecting ‘Load From File’ located at the 

bottom of the window. 
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Audio Loop-back

 

iD24’s Software Mixer has the ability to loop-

back audio so you can record or stream audio 

from di�erent applications on your computer 

using the dedicated Loopback channels. 

• These Loopback channels are located 

on input channels 11+12 and using the 

‘Input Routing’ option of the ‘Setup’ menu 

found in the menu bar when using the iD 

Software Mixer. Here you can select the 

audio source you would like to be sent to 

these Loopback channels.

On macOS:

On Windows:

The various sources you can select from in 

the menu are as follows:

• DAW 1+2 - Any audio being sent to 

outputs 1+2 of the iD24

• DAW 3+4 - Any audio being sent to 

outputs 3+4 of the iD24

• DAW 5+6 - Any audio being sent to 

outputs 5+6 of the iD24

• Master Mix - The audio mix created in 

the iD Software Mixer on the Main Mix 

tab

• Cue A - The audio mix created in the iD 

Software Mixer on the CUE A tab

• Cue B - The audio mix created in the iD 

Software Mixer on the CUE B tab 
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Recording/Streaming your 

Loop-back Source

Once you have selected the Loopback Inputs 

as your audio source in your recording/

streaming software, you can now set up your 

Loopback mix using the iD Software Mixer.

The first step is to decide which source you 

will use for your Loopback stream. 

If you wish to combine audio from your 

computer and microphones/instruments 

into a single mix then selecting either the 

Main Mix or one of the Cue Mixes is the best 

option as you can use the faders in the iD 

Software Mixer to send multiple channels to 

the same mix.

For example, below you can see the CUE A 

mix being used as the Loopback source with 

the Mic 1 and DAW 1+2 being sent to the CUE 

A mix. When recording the Loopback inputs 

with this setup, you would hear both the Mic 

Channel and the Computer Playback on a 

single stereo channel.

 Using the Loop-back Mixer

 

To record or stream your loopback mix in your 

audio software, you would simply need to 

select the Loopback channels as your input 

channels in your audio software. Depending 

on the software you are using, they may 

appear as either Loopback 1+2 or Input 11+12. 

For example, the image below shows how you 

would select the loopback input in Logic Pro X. 

 

A similar process would be used in other 

software. If you are unsure on how to adjust the 

input on your audio software, we’d recommend 

referencing the user manual for your software. 

On Windows, you may also need to adjust 

the audio device in your System settings from 

Analogue 1+2 to Loopback 1+2. 

Please note:  Some software will not allow you 

to adjust the input channel you are using and 

will just default to Channels 1+2. This limitation 

with some software can stop you from using 

loopback with this software as you are unable to 

select Channels 11+12.
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On macOS:

Open Finder and navigate to Applications 

> Utilities > Audio MIDI Setup. In the Audio 

MIDI Setup Utility, select the iD24 from the list 

of devices. Select the ‘Output Tab’ and click 

‘Configure Speakers’. You can then select 

which channels on the iD24 you would like 

to be your left and right outputs. Channels 

3+4 will relate to DAW 3+4, Channels 5+6 will 

relate to DAW 5+6...etc

On Windows:

Open the ‘Start’ menu and select ‘Settings’.   

In Settings, navigate to ‘System > Sound’. 

Using the ‘Output Device’ drop-down menu, 

you can select the channels you wish to use 

for your output. Again, channels 3+4 will 

relate to DAW 3+4, Channels 5+6 will relate to 

DAW 5+6...etc 

Otherwise, if you only wish to send audio from 

the computer without any microphone signal,  

you can just use one of the DAW Channels.

When selecting a channel or mix as the 

loopback source, a small loopback icon will 

appear on that channel/mix so you can check 

which source the loopback feature is being fed 

from with just a quick glance. 

Adjusting your Output Channels 

When setting up your loopback mix, you may 

wish to set up your computer audio so it is 

sent to DAW 3+4 or DAW 5+6 in order to keep 

it separate from your Main Monitor Mix which 

typically will be sent to DAW 1+2. 

In most DAW software, you should be able to 

create a new output send or adjust the output 

channel. The process to do this will vary so 

we recommend that you reference the user 

manual for your chosen software on how to 

adjust the output channel.

On Applications that don’t give the option to 

adjust the output channels (Media Players, 

Video calls…etc) then you may need to adjust 

this in the System Settings.
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Menu/Task Bar Icons

MacOS

On MacOS, the iD icon appears in the menu 

bar in the top right hand corner of the screen. 

This gives you quick access to various functions 

of the iD24. Please note that some functions 

are only visible when the iD24 is connected to 

the Computer

Show Mixer

Opens the iD Software Mixer. If the mixer is 

already open, this option will be greyed out. 

The Mixer cannot be opened unless the iD24 

is connected to the Computer.

About iD 

Displays information regarding the current 

version of the iD mixer application. 

Visit iD Knowledge Base

Opens a browser window for the Audient 

Helpdesk with helpful articles and FAQ’s.

Register Product 

Will open the registration screen allowing you 

to register your product to Audient ARC if you 

have not already done so as part of the initial 

setup.

Set Clock Source

Allows you to quickly adjust the clock source 

between the internal and optical clocks.

Set Looopback Source

Here you can select which Output Channel 

or Mix will feed the Loopback inputs.

Check for Updates

The iD application will check with the Audient 

update server for any available firmware

updates for iD24.

Quit

Fully closes the iD application.
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Windows

The Windows taskbar icon has all the same 

options of the MacOS menu bar icon but 

also includes some Windows specific options.

Set Sample Rate

Sets the operating sample rate of iD24. 44.1, 

48, 88.2 and 96kHz are the four options 

available. 

Set ASIO Bu�er Size

Sets the bu�er size of the iD24 between 16 

and 4096 samples. Higher sizes will take 

processing load o� your computer but will 

cause increased latency.

Firmware Update

Occasionally Audient will release a firmware 

update for iD24 in order to address

bugs, improve compatibility and add new 

features. Therefore, you may wish to check 

periodically for any updates.

This can be done by navigating to the Window 

menu and selecting ‘Check for Updates’.

The iD Application will then check with our 

update server if any updates for iD24 are 

available. If there is an update available 

then you will be prompted to install the latest 

version.

Now click ‘Next’ and you’ll be prompted to 

stop any playback through iD24. Click

‘Update’ and the update will begin. iD24 may 

turn o� and on a number of times.
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Keyboard Shortcuts

Location  Mac   Windows  Description

Faders  Alt + Click  Alt + Click  Resets fader to unity gain (0 dB)

Pans   Alt + Click  Alt + Click  Resets pan pots to central

         position 

Solos   Cmd + Click  Ctrl + Click  Clears all solos if clicking on a solo’d

         channel

         Overrides all other solos (for solo  

         exclusive) if clicking on an unsolo’d  

         channel

Meters  Alt + Click  Alt + Click  Clicking on peak hold indicator will  

         clear all clip indicators

System Panel Cmd + S  Ctrl + S  Save mixer configuration

   Cmd + O  Ctrl + O  Load mixer configuration

View Modes  Cmd + 1  Ctrl + 1   View Mic/Line Input

   Cmd + 2  Ctrl + 2  View Optical (Digital) Inputs

   Cmd + 3  Ctrl + 3  View DAW Mix Inputs

   Cmd + 4  Ctrl + 4  View System Panel

Please check the iD24 page online at audient.com/products/iD24

for the latest iD Application updates.

More shortcuts may be added without notification.

Keyboard Shortcut Index

To allow you to find all shortcuts for the mixer 

application in one place without having to 

go through each page of this manual please 

refer to this table:

https://audient.com/products/audio-interfaces/id24/overview/


DAW Setup



I/O Setup

Go to Setup > I/O... to label your inputs and 

outputs and ensure that iD24 is correctly

reporting 10-inputs and 6-outputs to and

from Pro Tools.

For more Pro Tools information consult your 

Avid user manuals & documentation.

Operation with Pro Tools

If using Windows, ensure that you have

followed the installation instructions found on

page 12.

With iD24 connected, launch Pro Tools and

ensure that a new session is created at

the desired sample rate. If you are using

Windows, make sure that you have already

set your Latency and Bu�er Size settings in

the iD System Tray before opening a project.

Changing these mid session will result in Pro

Tools needing to restart.

Playback Engine

Go to Setup > Playback Engine... and ensure 

that iD24 is set as the active playback

device. 

Pro Tools Setup
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Operation with Logic Pro

Once iD24 has been successfully installed

following the steps detailed after page 11 of

this manual, launch Logic Pro and check the

following:

Logic Pro > Preferences > Audio

Ensure that iD24 is selected as the active

audio device and set the bu�er size (to a�ect

system latency). If you are experiencing issues

with playback stability and CPU loading, try

increasing the bu�er size. This appears with

‘overload’ errors and/or pops and clicks and

distortion in the audio.

Logic Pro Setup

Logic Pro Setup

If you are using the iD mixer to monitor input

signals while recording, be sure to disable

Logic’s software monitoring to avoid phasing

as the same source will be heard twice with

a short delay between the low latency DSP

signal and the delayed software monitoring

signal.

Assigning I/O 

All of iD24’s input and output channels will

be available to Logic for routing. There are

a total of 10-inputs and 14-outputs reported

from the driver. You can rename input and

output channels to whatever you wish using

the I/O label function. This is a great way to

keep things organised.

Mix > I/O Labels



47

Operation with Logic Pro

If you are using an external clock source

(ADAT or S/PDIF) to clock iD24, please ensure 

that your Logic Pro project is set to the same 

sample rate when recording and playing 

back in a session, otherwise things may sound 

a bit sharp or flat!

File > Project Settings > Audio

If you are using the internal clock in iD24,

setting the sample rate via Logic Pro will 

update the iD24 sample rate to follow your 

session.

There may be a slight pause as the system

re-clocks. This is normal.

This can be verified in Audio MIDI Setup.

Macintosh HD > Applications > Utilities

For more Logic Pro information please 

consult your Apple user manuals & 

documentation.



48

Click on Audient iD24 in the side menu. Here 

you will see the main iD24 information, where 

clock sources can be set as well as activating 

i/o ports. Be sure to click Externally Clocked if 

clocking from another digital device via ADAT 

or SPDIF.

I/O ports can be renamed in the device panel 

such that they better represent what you 

connect to them (for example Main Monitors, 

Headphones). This is useful as any names 

chosen here will be those displayed when 

assigning i/o on track input/output channel 

routing.

Operation with Cubase / Nuendo

Once iD24 has been successfully installed 

following the installation process that can 

be found at the start of this manual, launch 

Cubase or Nuendo and head straight for the 

‘Studio’ menu:

Devices > Device Setup...

Select ‘Audio System’ from the list of options.

Select ‘Audient iD24’ in the dropdown menu 

to ensure that Cubase / Nuendo addresses 

the iD24 device driver.

Cubase/Nuendo Setup
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Here you can ensure that all buses have been 

created in Cubase / Nuendo and therefore 

all ports are addressable in your session. Add 

new buses and assign them to the necessary 

i/o if required.

Bus types can be set (mono / stereo) and 

the VST control room section can also be 

used. For more information regarding set-up 

please consult your Steinberg user manuals 

and documentation.

Operation with Cubase / Nuendo

Bu�er sizes can be set in the control panel 

within the VST devices display. It is ideal to 

keep them quite high to reduce CPU loading 

if you use the iD mixer as the input monitoring 

device while recording.

Close the Studio Setup panel and navigate to 

the Audio connections panel: 

Studio > Audio Connections (F4)

Cubase/Nuendo Setup
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In the Live Audio Preference panel you can 

set an appropriate bu�er size (this can be 

kept high if you are monitoring input signals 

for recording via the iD mixer. Ensure that 

iD24 reports as a 10-in, 14-out device to Live. 

If necessary you can limit the number of 

i/o channels reported as active inputs (from 

the driver) in Live by using the input and 

output config tabs. 

This is an excellent feature to help reduce 

CPU loading if all channels are not required.

Operation with Ableton Live

Once iD24 has been successfully installed 

following the installation process that can 

be found at the start of this manual, launch 

Ableton Live and head straight to:

Live > Preferences > Audio

Here navigate to the Audio tab and make sure 

that iD24 is assigned as the playback device.

For more information about setting up audio 

i/o refer to your Ableton Live user manuals & 

documentation. 

Ableton Live Setup
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Troubleshooting

“The unit will not power on”

Double check that the USB cable is plugged

in. If it still won’t power on, try using a di�erent

USB port on the computer and possibly even

a di�erent USB cable. If you are using a USB

hub, please try plugging iD24 directly into the

computer.

“I get clicks and pops on DAW 

playback”

This is most likely to do with setting the

bu�er size too low for your computer. This

can be caused by running very large projects

with a lot of plugins and virtual instruments.

Experiment with higher bu�er sizes. Typically

you want small bu�er sizes for tracking or

recording software synths to keep the latency

low. However when mixing it is fine to set a

slightly higher bu�er size as latency is not so

much of a problem.

“When I connect to my computer,

 I cannot play any audio out from iD24”

Firstly double check that the USB cable

connecting iD24 to your computer is

functional and attached at both ends.

Troubleshooting & FAQ.

Troubleshooting & FAQ

Double check that iD24 is set as the active 

playback device in your DAW and computer:

System Preferences > Sound > Output Tab 

> Audient iD24 (macOS)  

 

Control Panel > Hardware and Sound > 

Sound > Manage Audio Devices > Audient 

iD24  (Windows) 

Launch the iD mixer application to activate

communication between your computer

and iD24. This only needs to be done once

straight after power up. Once iD24 is set to the 

operational state you desire, you can quit the 

iD application and it will continue to function

as intended.

In the software mixer, locate the DAW

channels by pressing the DAW view button

and increase the level of DAW 1+2 fader.
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Double check that an appropriate clock 

source is selected (Internal for master 

operation), ADAT or S/PDIF clock for 

external slave operation. Ensure that you 

see the correct sample rate displayed in 

the Format drop-down menu.

If you are using Windows, go to the iD 

icon in the system tray and right click on it. 

This will bring up some settings including 

sample rate. Alternatively you can alter 

these settings in the Setup tab of the iD 

app. 

Change the sample rate to match that of 

the external ADAT device and session.

Troubleshooting

“I have clocking issues which include 

iD24 not locking to external ADAT or 

SPDIF devices or operating at the 

incorrect rate compared to my session”

If there is an issue with syncing of an external

device, the Status LED in the System Panel

will be red or yellow. If the status light is red

then iD24 cannot detect a clock signal from an

external device, and yellow if it can detect a

signal at the wrong sample rate.

To change sample rate in OSX go to Audio MIDI 

Setup found by navigating to the folder:

Macintosh HD > Applications > Utilities > Audio 

MIDI Setup

Ensure that Audient iD24 is seen as an audio 

device (Window Menu > Show Audio Window).
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FAQs

For more information and bug support,

please search our online Help Centre which 

can be found here:

support.audient.com

For technical support please create 

a ticket in our online support system, 

which can also be found in the support section 

of our website (see link above).

Troubleshooting

“How do I reset the iD mixer application 

to its default state?”

To reset the mixer application, quit the 

iD app completely, then navigate to the 

following folder and delete the state.xml file 

(it will replenish upon a fresh launch of the 

application):

Macintosh HD > User > Library > Application 

Support > Audient > iD > state.xml

(C:) > Users > yourusername > AppData > 

Roaming > Audient > iD > state.xml

Do not delete the parent folder as this will 

also contain your iD mixer presets.

“How do I make sure I have the latest   

version of iD firmware/software?”

To check for the latest updates to the

iD desktop mixer application please visit:

audient.com/id24/downloads

download and install the latest driver.

You will be made aware of firmware releases 

from the iD app when connected to the 

internet. Please refer to earlier in this user 

manual for more information regarding 

firmware updates.

https://support.audient.com/hc/en-us
https://support.audient.com/hc/en-us
https://audient.com/products/audio-interfaces/id24/downloads/
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Technical Specifications

Microphone Preamplifier: 

Line Inputs:

Digital Input:

Word Clock Output:

Digital Output:

DSP Mixer Latency
Round Trip (in-to-out)

MIC GAIN: 
MAXIMUM INPUT LEVEL:
CROSSTALK: 
THD+N @0dBu 1kHz:
MIC EIN:
CMRR
SNR:

FREQUENCY RESPONSE:
INPUT IMPEDANCE (Mic)
INPUT IMPEDANCE (Line)
PAD: 
HPF CUTOFF FREQUENCY:
PHANTOM POWER:
XLR COMBI FEMALE:

1/4” TRS JACK:

LINE GAIN: 
MAXIMUM INPUT LEVEL: 
THD+N @0dBu 1kHz:

8-CHANNEL ADAT:
4-CHANNEL ADAT:
STEREO S/PDIF

WORD CLOCK: 

8-CHANNEL ADAT:
4-CHANNEL ADAT:
STEREO S/PDIF

44.1kHz
48kHz
88.2kHz
96kHz

0 to +58dB
+12dBu
<-100dBu @ 1kHz & 10kHz
0.0015%, -96dB
-13dBu A-Weighted
>75dB@1kHz
97.5dB Unweighted, 100dB 
A-Weighted
+/- 0.5dB 10Hz to 40kHz
3kΩ balanced
10kΩ balanced
-10dB
100Hz
48V +/-4V @ 10mA/Channel
Pin 2 (Hot), Pin 3 (Cold) & Pin 
1 (Shield) 
TIP (Hot), RING (Cold) & 
SLEEVE (Shield)

-10 to +48dB
+22dBU
0.0013%, -97dB

44.1kHz to 48kHz
88.2kHz to 96kHz (SMUX)
44.1kHz to 96kHz (Stereo) 

44.1kHz to 96kHz

44.1kHz to 48kHz
88.2kHz to 96kHz (SMUX)
44.1kHz to 96kHz (Stereo) 

0.344ms
0.312ms
0.188ms
0.177ms

Analogue to Digital Converter:

MAXIMUM INPUT LEVEL:
CROSSTALK:
FREQUENCY RESPONSE:

THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:
INPUT IMPEDANCE:
1/4” JACK:

12.5dBu=0dBFS
@1k -135dB, @10k -125dB
+/- 0.2dB 0.5dB 10Hz to Fs/2 
(Nyquist)
0.0004%, -108dB
122dB A-weighted
>10kΩ
TIP (Hot), RING (Cold) & SLEEVE 
(Shield)

MAXIMUM OUTPUT LEVEL:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE: 
CROSSTALK:
FREQUENCY RESPONSE:
OUTPUT IMPEDANCE:

MAX LEVEL INTO 30R: 
MAX LEVEL INTO 60R: 
MAX LEVEL INTO 600R:

NO. OF INPUT CHANNELS: 
NO. OF OUTPUT CHANNELS:
CONNECTOR: 
INCLUDED CABLES:

18.5dBu=0dBFS
0.0006%, -104dB
124dB A-weighted
-117dB @ 1kHz, -101dB @ 10kHz
+/- 0.2dB 10Hz to Fs/2 (Nyquist)
<50Ω unbalanced

2.63V Peak, 1.87V RMS, 232mW
4.28V Peak, 3.03V RMS, 295mW
7.91V Peak, 5.6V   RMS, 104mW

10 (2 Analogue, 8 Digital)
14 (6 Analogue, 8 Digital) 
USB Type-C 
1m USB 2.0 Type-C to Type-C

Headphone Outputs:

USB 2.0 High Speed:

D.I GAIN:
MAXIMUM INPUT LEVEL:
THD+N @ 0dBu (1kHz):
SNR:

FREQUENCY RESPONSE:
INPUT IMPEDANCE:
1/4” JACK:

0 to 58dB
+12 dBu 
0.0075%, -82dB
95dB unweighted, 97.5dB 
A-weighted
+/- 0.5dB 0.5dB 10Hz to 40kHz
500kΩ unbalanced
TIP (Hot) & SLEEVE (Shield)

D.I / Instrument Input:

Digital to Analogue Converter 

MAXIMUM OUTPUT LEVEL:
THD+N @ 1kHz -1dBFS:
DYNAMIC RANGE:
CROSSTALK: 
FREQUENCY RESPONSE:
OUTPUT IMPEDANCE:
1/4” JACK:

12dBu=0dBFS
0.0003%, -110dB
126.5dB A-weighted 
-130dB @ 1kHz, -115dB @ 10kHz
+/- 0.1dB 10Hz to Fs/2 (Nyquist)
<100Ω
TIP (Hot), RING (Cold) & SLEEVE 
(Shield)



55

198mm

1
3

4
m

m

6
6

m
m

Dimensions



Warranty Statement

Please read through this Limited Hardware Warranty before using Audient hardware.

Audient products are designed and built to the highest standards, using premium components 

designed to deliver years of reliable performance.

In the event of a manufacturing defect becoming apparent during the 3 year limited warranty 

period, Audient will ensure the product is repaired free of charge.

Audient are not liable for direct or consequential loss or damage resulting from the goods and/or 

their use.

Warranty Limitations

The Limited Warranty for any product purchased on or after February 01 2021 is for a period of 3 

years from the original purchase.

Additionally, the 3-year Limited Warranty is retrospectively o�ered on any product purchased 

after February 01 2018.

Without exception you will need to provide a copy of your original dated invoice or store receipt 

identifying the product serial number as part of the consideration of the grant of warranty.

In the event that you are unable to provide proof of purchase, you should request a copy of your 

receipt from the reseller from whom you purchased the product.

For the full ‘Terms and Conditions’ please head over https://audient.com/warranty/

Warranty
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https://audient.com/warranty/


Audient Ltd

Aspect House

Herriard

Hampshire

RG25 2PN

United Kingdom

Tel: +44 (0) 1256 381944

audient.com
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Service Information

iD24 contains no user-serviceable components, please refer to qualified service personnel 

for diagnosis and repair. Your warranty will be void if you tamper with the device at component 

level. If you have any questions with regard to the repair, please contact Audient Ltd.

If your unit is in warranty, please contact your dealer directly for a repair or replacement (at the 

discretion of the dealer).

For out of warranty repairs, please contact Audient Ltd, after which a Return Materials 

Authorization (RMA) number will be assigned. This number will serve as a reference for you 

and helps facilitate and expedite the return process. When the unit is returned please include this 

RMA number along with a description of the fault inside the packaging box.

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or make 

an enquiry, please visit: support.audient.com

Service

https://audient.com/
https://support.audient.com/hc/en-us
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A  Amperes

ADAT  Alesis Digital Audio Tape

ADC  Analogue to Digital Converter

DAW  Digital Audio Workstation

ASP  Analogue Signal Processing

CPU  Central Processing Unit

CUE  Artist Headphone Mix

DAC  Digital to Analogue Converter

dB  Decibel

dBu  Decibel referenced to 0.775Vrms = 0 dBu

dBFS  Decibel Full Scale

DC  Direct Current

D.I  Direct Injection (Instrument Input)

DoC  Declaration of Conformity

DSP  Digital Signal Processing

EQ  Equaliser

FAQ  Frequently Asked Questions

FCC  Federal Communications Commission

GB  Gigabyte

GUI  Graphical User Interface

HPF  High Pass Filter

HV  High Voltage

i/o  Input / Output

JFET  Junction Field E�ect Transistor

LED  Light Emitting Diode

RoHS  Restriction of Hazardous Substances

RAM  Random Access Memory

S/PDIF Sony Philips Digital Interface Format

THD+N Total Harmonic Distortion + Noise

TRS  Tip Ring Sleeve (1/4” Jack Balanced)

TS  Tip Sleeve (1/4” Jack Unbalanced)

USB  Universal Serial Bus

V  Volts

XLR  Extra Live Return, Extremely Low Resistance, Canon X Series, Latching,

  Resilient Rubber Compound... or make up your own!

Glossary


